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ICATS IT CONTEST 2017

ADOLESCENTS (GRADE 9 & 10 / O-LEVELS)

TIME ALLOWED : 90 MINUTES
MAXIMUM MARKS : 90
TOTAL QUESTIONS : 30 MCQS

INSTRUCTIONS

11.
12.

13.

14.

15.

DON'T START ATTEMPTING THE PAPER UNTILINSTRUCTED BY THE INVIGILATORS.
INSTRUCTIONS FROM THE EXAMINATION INVIGILATORS MUST BE CARRIED OUT
PROMPTLY.

WRITE YOUR NAME, FATHER NAME, SCHOOL NAME, ADDRESS ETC AT THE BUBBLE SHEET
(ANSWER SHEET) ONLY.

RECORD ALL ANSWERS ON THE BUBBLE SHEET ONLY. SELECT BEST ANSWER FROM THE
FOURGIVEN OPTIONS AND MARK ONLY ONE OPTION IN EACH QUESTION.

USE BLUE / BLACK INK TO FILL UP THE CIRCLES FOR YOUR ANSWERS ON THE BUBBLE SHEET.
USE OF LEAD PENCILIS NOT ALLOWED.

USE OF ANY HELPING MATERIAL INCLUDING CELL PHONES AND ELECTRONIC DEVICES IS
STRICTLY PROHIBITED.

EVERY CORRECT ANSWER EARNS THREE POINTS. THERE WOULD BE NEGATIVE MARKING.
ONE POINTWOULD BE DEDUCTED FOR EVERY INCORRECT ANSWER.

CANDIDATES MAY NOT LEAVE THE EXAMINATION ROOM UNESCORTED FOR ANY REASON,
AND THIS INCLUDES USING THE WASHROOM.

NO MATERIALS OR ELECTRONICDEVICES SHALL BEBROUGHT INTO THE ROOM.

. THERE ARE FIVE CATEGORIES OF THE CONTEST AS UNDER:

TODDLERS (GRADE 1 & 2)

KIDS (GRADE3 &4)

JUNIORS (GRADE5 &6)

JUVENILES (GRADE 7 & 8)

ADOLESCENTS (GRADE 9 & 10 / O-LEVELS)

ONLY REGISTERED STUDENTS CAN PARTICIPATE IN THE CONTEST.

NO CANDIDATE SHALL TAKE OUT OF THE HALL ANY ANSWER BOOK(S) OR PART OF AN
ANSWER BOOK, WHETHER USED OR UNUSED, OR OTHER SUPPLIED MATERIAL.

IF A PARTICIPANT DOES NOT UNDERSTAND A WORD OR PHRASE ON THE EXAM PAPER,
NEITHER EXAMINER NOR INVIGILATOR IS PERMITTED TO ANSWER.

FOR INFORMATION ABOUT UPCOMING CONTESTS OR PROVIDING VALUABLE FEEDBACK,
PLEASE VISIT WWW.CATSCONTESTS.ORG

ANY ACADEMIC MISCONDUCT OR MALPRACTICE MUST BE REPORTED TO INTERNATIONAL
CATS CONTESTS AT INFO@CATSCONTESTS.ORG
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2B The earliest known device that produced numerical calculations is the

Y Punched-card loom [} Abacus Analytical Engine 2] None of these

X3 which one is the feature of Fifth generation computers?

I The introduction of the integrated circuit.

5] Artificial Intelligence & the Internet.

E The introduction of the integrated circuit, artificial intelligence and parallel processing.
E None of these

CEY which of the following statements is not true about the FORTRAN language?

ﬂ FORTRAN is a high level language.

E A FORTRAN program, written for the IBM-PC, is totally different from a FORTRAN program
written for execution on the SUN machine.

E FORTRAN is extensively used to write programs for performing scientific computation.
2] Al of the above.

Steve Jobs and Steve Wozniak built their first computer using a wooden box.
Their company has grown and is still around today. The name of the
company is:

u Microsoft B Linux ﬂ Apple

] windows

ICATS IT Contest 2017 (Adolescents - Grade 9 & 10)
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You have a system that periodically locks up. You have ruled out software, and
now suspect that it is hardware. What should you do first that could help you
narrow it down to the component at fault?

ﬂ rotate the RAM E replace the RAM

E replace the level 2 cache SIMM E disable the CPU cache in CMOS

Headers and Footers in different sections of a document are connected to each
other until you perform an action to remove this link. What is the name of the
function and where will you find it?

I Continue from Previous Section, which is located in the Page Number Format dialogue box.

E Same as Previous, which is located under the Header & Footer Tools contextual tab, in the
Navigation group.

Unlink from Previous, which is located under the Header & Footer Tools Contextual Tab, in the
Navigation group.

E Link to Previous, which is located under the Header & Footer Tools Contextual Tab, in the
Navigation group.

Proactive participation in school / colleges’ educational uplift through
providing objective educational assessment tools is one of the prime
responsibilities assumed by ICATS.

ICATS competition is a source of
inspiration for all the participants to
challenge their academic and
sporting skillset.

ICATS helps you identify your strengths and weaknesses which you may
not always know until your competition points them out. It helps you to
narrow your focus on a specific problem to improve it or your competitive

Study the screenshot of a block quote above. Which of the follow represent the
first step in creating such a block quote?
I Press the Increase Indent button once to indent the text and create the block quote.
5] Move the Left and Right Indent Markers on the Ruler to create the block quote.
ﬂ In the Paragraph dialogue box set a value for Left and Right Indents to create the block quote.
E Select the paragraph or position your cursor in the paragraph you wish to apply the indents to.

ICATS IT Contest 2017 (Adolescents - Grade 9 & 10)
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Which of the following best describes the function of the button on the Ribbon
circled in orange in the screenshot above?

ﬂ You use it to change the font type of selected text.
E You use it to copy the formatting of selected text.
You use it to clear formatting from selected text.
E You use it to place a border around selected words.
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Study the screenshot above. How would you remove the lines through the text?

I Use the Clear Formatting button to remove the Strikethrough effect.

E Press Ctrl+Shift+n to return the formatting to the default font formatting for the document.
E Select the text and toggle the Strikethrough button to 'off".

E All of the above are correct.

ICATS IT Contest 2017 (Adolescents - Grade 9 & 10)
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Study the screenshot above. The above menu appears when you right-click
after copying text. Which of the following options best describes what will
happen to text you paste by using the Paste Option “A” circled in yellow above?

ﬂ Content will be pasted as unformatted text only.
B Content will be pasted in uppercase letters only.
ﬂ All the content you copied will be pasted.

E All of the above options are correct.

Q11. FRIEE Fikd- TIEY T 0
ﬂ Home Insert Page Layout Formulas
f!' cut Calibri L
<3 Copy - _
ite B Z U- - O-A-

7 Format Painter

Study the screenshot above. Lilly wishes to remove some of the buttons and
vertical lines on the Quick Access Toolbar (circled in red in the screenshot
above). How can she do this quickly?

She needs to select the button or vertical line to remove and press the Delete button on her
keyboard.

E She needs to go to the Insert tab and select Edit the Quick Access Toolbar Button in the Edit
group to remove buttons.

[ she can right click on a button or vertical line and select Remove from Quick Access Toolbar
from the list.

E It is not advisable to edit the Quick Access Toolbar without advanced Microsoft Office
knowledge.

ICATS IT Contest 2017 (Adolescents - Grade 9 & 10)
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Study the screenshot above. When reviewing this document, Lauren noticed
that there were several instances where a heading was on a separate page
from the paragraph that followed it. How can she fix this and stop it from
happening again?

u If she presses enter a few times before the heading, it will move the heading down to the next
page.

E If she selects the text and then tick: Keep Lines Together in the Paragraph dialogue box
under the Line and Page Breaks tab, it will keep the lines of text and the heading together.

ﬂ If she selects the text and then tick Keep With Next in the Paragraph dialogue box under the
Line and Page Breaks tab, it will keep the lines of text and heading together.

E If she selects the text and then press Ctrl+Shift+Enter, it will manually keep lines of text
together.

What is the purpose of the Widow/Orphan control tick box in the Paragraph
dialogue box under the Line and Page Breaks tab?

ﬂ It automatically removes extra page breaks within a document when ticked.
E It controls how paragraphs are spaced out and prevents paragraphs from becoming separated.
It prevents one line of text appearing on one page and the rest of the paragraph on another.

E It allows you to use the Keep With Next and Keep Lines Together options.

ICATS IT Contest 2017 (Adolescents - Grade 9 & 10)
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Study the screenshot above this question. What are the vertical lines
in-between some of the buttons on the Quick Access Toolbar called and how
are they inserted?

ﬂ They are called separators. Insert them from the"'Modify the Quick Access Toolbar™ dialogue
box.

E They are called dividers. Insert them from the"'Modify the Quick Access Toolbar"' dialogue
box.

ﬂ They are called separator lines. Insert them by right-clicking on the Quick Access Toolbar and
selecting “Insert Line Break”.

E They are called division lines. Insert them by grouping items on the Quick Access Toolbar
together by moving them up or down.

Which of the following is the easiest method to move to the start of a 135
page document?

u Pressing Home will take you to the beginning of the document.

E Pressing Control + Home will take you to the beginning of the document.

ﬂ Using the scrolling wheel on your mouse to scroll up to the first page of the document.
E Pressing Control + Up arrow to move to the beginning of the document.

ICATS IT Contest 2017 (Adolescents - Grade 9 & 10)
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Study the Navigation Pane in the screenshot above. It notes that the word
“contract” occurs 23 times in this document. How can I use the navigation
pane to QUICKLY scroll through each instance of the word “contract”
individually?

I Press the Previous Search Result and Next Search result buttons to scroll upwards and
downwards through each instances of the word “contract” in the document.

B Scroll through the document using Control + Page Up and Control + Page down. All the
instances of “contract” will be highlighted by the Navigation Pane and easy to find.

Open the Go To dialogue box and press the Next and Previous buttons to go through the results.

E Select the first instance of the word “contract” and press Control + G to navigate through all
instances of the word.

Study the screenshot above. What is the function of the button that is circled in
yellow?

u This is the Text Direction button. Click on it to change the direction of text in the Text Box.

E This is the Paragraph Formatting button. Click on it to change the line spacing of paragraphs
in a Text Box.

E This is the Text Box Spread Tool. Click on it to ensure your text is spaced out to fill the entire
Text Box.

E This is the Text Box Alignment button. Click on it to align text within a Text Box and ensure
different text boxes do not overlap.

ICATS IT Contest 2017 (Adolescents - Grade 9 & 10)
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(Q18.) | c13 - £ =SUM(C3:C12)

| A B c D
1 Birthday Party - Dinner at Scouborgs
2 Invitees: Fish Steak
3 JAMES LUVITT $45.00
4 | GLORIA SMITH $52.00
5 FREDDIE WHITE $45.00
6 PETER LIMP $45.00
7 SONIA KAPOOR $52.00
8 MATT LORR $45.00
| o BRAD sKIvITT $45.00
10 FRONA SKUDENSKI $52.00
11 MINA MACKLIN $45.00
12 RUTH LACE $52.00
[13] Totals: $270.00] _$208.00]

Study the screenshot above. What will happen to the formula and/or the
result (total) in cell C13 if a value is entered into the highlighted cell (C5)?

u The total in C13 will automatically update to include the amount entered.
E Nothing will happen. The formula will have to be reinserted to include the new value.

ﬂ The formula will return an error message as the numbers that were included in the original
formula are not the same any longer.

E Cell C13 will display the formula instead of the total amount.

m E19 - 5| 2
' 8 < D _E
1 Date of Hire Department Office Location
2 Barbara smith 6/1a/92 Tech. Support 2
3  Carryn Gary 10/1/03 Engineering 1
4 Lee Marsh 6/1/01 Development 8
5 Barry Gummy 10/17/12 Facilities (]
6 (GinalJames 1/26/00 Accounting a
7 Lawrence Crabtree 12/15/10 Human Resourc 8
8 Percy Nome 7/18/95 Accounting 9

What is a quick way of finding any blank cells in a region of data?

I Use the Go To Special function and select 'blanks' from the list.

E Use the Go To Special function and select 'current region' to highlight only cells containing
data.

E Use the Select All button to select the entire worksheet (it will automatically exclude blank
cells).

E Use the Go To function and type 'Blank’ into the Reference box to find empty cells.

ICATS IT Contest 2017 (Adolescents - Grade 9 & 10)
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[ Q20.) B - B | € | b E F
>f High Street

|Name: JobTitle: Duties

Peter Handy Ma Clean, cut the lawn, walk the dogs
|Laura Writer  Write articles and content for webpages
|Karen  Manager Manages a fast food store
|Adam Chief Offi Directs company, philatropist
'Steffie  Printer Print and sets documents

Michel Contracto Performs duties as needed.

00~ 'h U bW N

Study the example of a spreadsheet in the image above. Which steps do I need
to take to ensure the title that is cut off in row 1 appears centered across
column A, B and C?

N Resize the cells until the title fits across these columns.

5} Double click the column divider line in column C to adjust it.

E Select the cell containing the title text (Al). Click Merge & Centre.
E Select the three cells (A1:C1). Click Merge & Centre.

@ D4 v £ =SUM(B4,C4)*$BS1

A B C D E |
VAT: 1.05

1
2

3 Project UnitCost Labour Total

4| 785 $52.00 $18.00
5 923 $103.00 $63.00 $174.30
6 221 $25.00 $8.00  $34.65

7 565 $36.00 $2.00 $39.90
8 321 $45.00 $18.00 $66.15
9 243.23 $56.00 $8.00  $67.20
10 25.1 $85.00 $55.00 $147.00

Study the screenshot above. What will happen to the formula contained in
D4:D10 should we move the contents of Cell B1 (1.05) to cell E25 on the
worksheet?

u The formula will update so that the last part of it will be *$E$25.
IE} There will be no change to the formula or value of the cell.

[d The cells will return a #REF! error.

2] The formula will no longer calculate the correct values.

ICATS IT Contest 2017 (Adolescents - Grade 9 & 10)
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= F
8 | C D

1 Weekly Groceries:

2

3 Milk $15.00
4 Bread $8.90
5 Cheese $25.00
6 Meat $350.00
7 Wine $100.00
8 Water $20.00
9 Pasta $20.00
10 Rice $10.00
11 Fruit $100.00
12 Veg $50.00
13 Condiments $10.00
14 Cleaning $20.00
15 Treats $120.00
16 Total:

17

Study the screenshot above. James wishes to work out the total for the
weekly grocery bill for himself and his roommate. The total should display in
cell B16 (highlighted in green). Which of the following methods will be
successful in displaying the total?

N Select cells B3:B15, press AutoSum and then press enter.

E In cell B16 type the formula: =Sum(B3:B15) and press enter.

[& 1n cell B16 type the formula: =B3+B4+B5+B6+B7+B8+B9+B10+B11+B12+B13+B14+B15
2] Al of the above options are correct.

Q23] A
Laura
4
Karen
5
Adam
6
Steffie

7

B C D

Write articles and content for webpages
Writer

Manager Manages a fast food store
Chief Officer

Directs company, philatropist

Printer Print and sets documents

Study the example above. You will note the contents in many of the cells are
not lining up and look inconsistent. What is a quick way of fixing this?

ﬂ Select the whole spreadsheet and click on the Merge & Centre button.
E Select the whole spreadsheet and click on the Wrap Text button.

E Select the whole spreadsheet and click on one of the horizontal alignment buttons and one
of the vertical alignment buttons.

E Select the whole spreadsheet, click on the Wrap Text button and then on one of the
horizontal alignment buttons.

ICATS IT Contest 2017 (Adolescents - Grade 9 & 10)
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m d9- == Book1xisx - Microsoft Excel - o iEN

“ Wi, MGt PeoRtmeit  Forsuls  Dsts  MeMes View ' QPoo B

K16 - [ % -
A B C D E F G =

1 Total Sales by Quarter:

2 Sales Person: Q1 Q2 Q3 Q4 Total Bonus 1

3 Janine $ 980005 260.00|S 480.00|S 102005 182200|S5 91.10

4 Rita $ 1,05200|S6 852.00|$ 1,023.00|$ 1,0001.00|S 392800 | 5196.40

5 Lahone $ 260005 12000(S 560.00|S 362.00|$ 1,302.00|S 6510

6 Sajev S 968.00|S 36900|S 980.00|S 1423.00|5 3,740.00| 5187.00

7 Raka S 12300|S5 258.00|S 85200|$ 1,059.00|S5 2,292.00| 5114.60

8 Rajesh S 36900|S B85500|S 97800|S 23000|S5 243200/ 512160

9 Cora S 15200|S 39800|S 98200|5 1,358.00|S 2,890.00| 5144.50

10 Neetu $ 982.00|S 98600(5 987.00|% 896.00|S 3,851.00| 519255

11 Sameera S 258.00|95 1,274.00| S 25.00| S - S 1,557.00| S 77.85

12

Study the screenshot above. Rakesh is looking for the usual buttons and
groups on the Ribbon, but they all seem to have disappeared. What should
Rakesh do?

u The Window is minimized. Rakesh must resize the window by pressing the square maximize
button to restore the window.

B The View type selected is hiding the Ribbon. Rakesh must click on the View tab and select
Normal View.

ﬂ The Ribbon is minimized. Rakesh must press Ctrl+F1 to restore it.

E There are no buttons to display for the current worksheet. Rakesh must create a new
worksheet to restore the Ribbon.

Laurie often needs to print, change page set-up and spellcheck slides. She
hates having to search for these function buttons in different places on the
Ribbon every time she wishes to use them. What is the solution?

I She could add the buttons for the above functions to the Quick Ribbon Status Bar at the
bottom of the screen.

IE] She could add the buttons for the above functions to the Quick Access Toolbar at the top
left-hand corner of the screen.

E She could create shortcuts on her desktop for the above functions to ensure quick access.

E She could add all of the above functions to the Status Bar at the bottom of the PowerPoint
screen.

ICATS IT Contest 2017 (Adolescents - Grade 9 & 10)
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Study the screenshot below. How can you replicate the position of the Text
Box on this slide, i.e. diagonally across the screen?

LS O 2O M OO AT RO DU R DO RO BN R S B0 BCRC R RO RO AN OO BOR RN R o

u Use the Word Art function and select the diagonal text option.

E Use the rotation handle on a Text Box to rotate the text diagonally.

E Insert the text as a diagonal image that is automatically at the right angle.
2] Al of the options listed above are correct.

To get a set of boxes to be separated by equal spaces in MS PowerPoint, as
those in the image below are, which option would you use?

COMPETENCE

APTITUDE

TESTING

SERVICES
u The Align Middle option. E The Distribute Vertically option.
The Align Centre option. E The Distribute Horizontally option.

ICATS IT Contest 2017 (Adolescents - Grade 9 & 10)




Page 13 of 16

Click to add title

* Click to add text

Examine the screenshot above. What are the items circled in yellow called and
what will happen when you click on them?

I These are called image icons. They are inserted to make a slide lock more colorful and
professional.

B These are called content holders. They are hyperlinks to where content such as a table or
chart is located.

E These are called placeholders. They will insert an object such as a table or a chart when
clicked.

E These are called format holders. They work when the PowerPoint presentation is in Live
preview.

XD Which of the following HTML code is correct to align following paragraph to
the right of available space on browser window?

u <p text-align="right"> E <p style="text-align=right”>

ﬂ <p style="align:right”> E Botha &c

@ What is the attribute for <image> tag?

A G B ur

ICATS IT Contest 2017 (Adolescents - Grade 9 & 10)
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ICATS IT CONTEST 2018
ADOLESCENTS (GRADE 9 & 10)

TIME ALLOWED : 90 MINUTES, MAXIMUM MARKS : 90
TOTAL QUESTIONS : 30 MCQS

INSTRUCTIONS

1.

DON'T START ATTEMPTING THE PAPER UNTIL INSTRUCTED BY THE
INVIGILATORS.

INSTRUCTIONS FROM THE EXAMINATION INVIGILATOR MUST BE CARRIED
OUTPROMPTLY.

CAREFULLY RECHECK YOUR NAME, FATHER NAME, SCHOOL NAME, ADDRESS
ETC AT THE BUBBLE SHEET / ANSWER SHEET.

RECORD ALL ANSWERS ON THE BUBBLE SHEET ONLY. SELECT BEST ANSWER
FROM THE FOUR GIVEN OPTIONS AND MARK ONLY ONE OPTION IN EACH
QUESTION.

USE BLUE / BLACK INK TO FILL UP THE CIRCLES FOR YOUR ANSWERS ON THE
BUBBLE SHEET. USE OF LEAD PENCILIS NOT ALLOWED.

USE OF ANY HELPING MATERIAL INCLUDING CELL PHONES AND
ELECTRONIC DEVICESIS STRICTLY PROHIBITED.

EVERY CORRECT ANSWER EARNS THREE POINTS. THERE WOULD BE
NEGATIVE MARKING. ONE POINT WOULD BE DEDUCTED FOR EVERY
INCORRECT ANSWER.

CANDIDATES MAY NOT LEAVE THE EXAMINATION ROOM UNESCORTED FOR
ANY REASON, AND THIS INCLUDES USING THE WASHROOM.

NO MATERIALS OR ELECTRONIC DEVICES SHALL BE BROUGHT INTO THE
ROOM.

. THERE ARE FIVE CATEGORIES OF THE CONTEST AS UNDER:

A TODDLERS (GRADE 1-2)
B. KIDS (GRADE3—4)

C. JUNIORS (GRADE 5—6)

D JUVENILES (GRADE 7 8)

E ADOLESCENTS (GRADE 9—10 / O-LEVELS)

. ONLY REGISTERED STUDENTS CAN PARTICIPATE IN THE CONTEST.
. NO CANDIDATE SHALL TAKE OUT OF THE HALL ANY ANSWER BOOK() OR

PART OF AN ANSWER BOOK, WHETHER USED OR UNUSED, OR OTHER
SUPPLIED MATERIAL.

. IF A PARTICIPANT DOES NOT UNDERSTAND A WORD OR PHRASE ON THE

EXAM PAPER, NEITHER EXAMINER NOR INVIGILATOR IS PERMITTED TO
ANSWER.

. FORINFORMATION ABOUT UPCOMING CONTESTS OR PROVIDING VALUABLE

FEEDBACK, PLEASE VISIT WWW.CATSCONTESTS.ORG

. ANY ACADEMIC MISCONDUCT OR MALPRACTICE MUST BE REPORTED TO

INTERNATIOAL CATS CONTESTS AT INFO@CATSCONTESTS.ORG
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m The first computers used vacuum tubes for circuitry and magnetic drums for
memory, and were often enormous, taking up entire rooms. They were very
expensive to operate and in addition to using a great deal of electricity,
generated a lot of heat, which was often the cause of malfunctions. This
generation of computers relied on machine language to perform operations,
and they could only solve one problem at a time. Input was based on punched
cards and paper tape, and output was displayed on printouts. What generation
of computers are we talking about?

u First Generation - 1940-1956: E Second Generation - 1956-1963:
[d Third Generation - 1964-1971: 2] Fourth Generation - 1971-Present:

m Though punch cards are so symbolic and have been used for over than 200
years in various fields of expertise, they actually were slow, low-capacity and
required a lot of devices, efforts and time for processing. That's why, during the
1960s, the punch card as the primary medium was gradually replaced by better,
more capable and more efficient devices. It became the most popular way of
storing of computer data until the mid 1980s.

u Magnetic Tapes E Punch cards Floppy disk E Hard drive

This seventeenth century scientist, mathematician and philosopher is credited
with having built the first adding machine; a programming language is also
named after him. What is his name?

N steve Jobs 3 John Backus [d 10hn von Neumann 2} Blaise Pascal

ICATS IT CONTEST 2018 (ADOLESCENTS - GRADE 9 & 10
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m Who is considered father of the internet and now vice president of Google?

ﬂ Bill Gates E Larry Page George Bush E Vinton Cerf

5 whatis a common resolution for a computer monitor?

Y 320x240 [ 1024x768 [d 3600x2150 ) 524x524

I3 The following are the steps to shutdown a computer. Which of them is/ are
correct?

m Click Start button, click ok. Select the Shut down option and click ok, to shut down Windows
E Click Start button, click shutdown, select Shut down option, click ok, to shut down windows.

Click Start button, click shutdown, select the shut down option and click cancel, to shut down
windows.

E Click Start button, click shutdown, select the restart option and click the ok, to shut down
Windows.

’ ICATS IT CONTEST 2018 (ADOLESCENTS - GRADE 9 & 10)
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There are few keys on the keyboard that are available at two places on it.
Now which of the following statements is/are incorrect?

1. Shift keys are found in two places.

2. Backspace keys are found in three places.

3. Spacebar keys are found in two places.

4. Enter keys are two in number on the keyboard.

u 1 and 3 are incorrect E 2 and 3 are incorrect
1, 2 and 4 are incorrect E All are incorrect

Look at the image below. Where can you click ONCE to automatically sort the
files from smallest to largest?

3 Dezktop - XVplorer === 30-day Trial Version 2 - 18.90.0100 = o x
File Edit View Go Faventes User Seripling Tools Panes Tabsets Window Help
- = - = i =11 1 e
4 BEQOA IOAOX O M wEBAAYY-WOPHREHIIS &Y- O
B Desktop
B This PC &= 0 { Documems - Downioads J Andrg +
# @ Links BN
= e () - o ~
= 5 b ts
3 a““‘;’"”u SRecyeleBin File folder AD018 50917 . | W2/201T 1d6T
s o
M M’:‘ T + Documents and Settings File folder YRR HER.., VINE0632 .
. "
i ‘; " Pedlogs File folder TMR0T 2400, 92002073463 .
44 4l )
"'c;‘c “F‘H Program File: File foldet /0185509 . 20/2017 146:33 .
;N ": g Program Files (86) File folder 2272018 52712 Y2VHNTIAEDS .
R PregramDats File folder URROBEII. VN7 I
L o9
& Recycle Sin Recovery File folder YRROIETO6IE . V2B 20638 .
System Volume information File folder /2273016 5:2250 .. -4723/2018 20500 ...
Users File folder URANBEIED . 9/EN2017 1G4S
Wintows File folder YZR018EOR02 . /22017 10:85
¢

ﬂ Name E Date modified E Type E Size
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The best way to move some text from page No. 2 of your document to another
part of your essay at page No. 47 would be to

ﬂ Delete the text and then re-type it.
E Highlight the text, and then drag it into place with the mouse.
Highlight the text, and press the up or down arrows to move it.

E Highlight the text, press ctrl-x then select the place you would like
to text to appear and press ctrl-v

EXY Which program can open the below given file?

ICATS.jpg

u Paint E Excel Word E Movie Maker

Taha wants to insert the words: "American History" at the top of every page
of his 83 page essay. Which of the following is the EASIEST method for him
to do this?

ﬂ He can type the words "American History" onto the first page of the document and then
copy and paste it onto all of the other pages.

B He can type the words "American History" onto the first page of the document and click on
the Header button to repeat it on all of the other pages.

E He can type the words "American History" onto the first page after selecting the Header
region of the document by clicking the top edge of the page. It will automatically be repeated
in all subsequent header regions of the document.

E None of the above options are correct.

_
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m In creating the heading for your Science assignment, you carried out the three
stages below:

Stage Screen View Process

1 The life of a star Heading text

2 | (] |Boxadded
3 The life of a star Completed heading

What process did you carry out in Stage 2 to give the screen view shown in
Stage 3?

Cut

Copy
Paste Options:

!

iD

Add Text

|

|

Edit Points

Bring to Front »
Send to Back ¥ O Sendto Back
Hyperlink... 0O Send Backward

Insert Caption.. ,J'. Send Behind Text

Bl @ 88 B & i

Wrap Text r

Set as Default Shape

i

More Layout Options...

{9
13
¥

Format Shape..

Bring to Front E Send to Back ﬂ Send Backward E Send Behind Text
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3ED study the screenshot below. How would you remove the lines through the

text?
Home Insert Page Layout References Mailings Review View Develope
=1 4 ibri v v| A" a7 v | L v = vii=y | iBEE | A
By T Calibri 11 A A A o MR-l —R Sl % - T A:
| —
PasteJ B 7 U~ ahe x, X' W A EEEBEE = OB~ "
Clipboard ' Font " Paragraph
(L] --l'g-z-a'-s---.aa-:-;'-:-6-|=-7'=I—a-n-'9'-

™

| Hisrecommendedthat:

Use the Clear Formatting button to remove the Strikethrough effect.
Press Ctrl+Shift+n to return the formatting to the default font formatting for the document.

Select the text and toggle the Strikethrough button to 'off".

Al
B
D

All of the above are correct.
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You wish to see what each Font type will look like applied to the heading
of your document. Which of the following is the QUICKEST way for you to do
this?

ﬂ By hovering your mouse cursor over each font name in the Font list to see what it will look
like before being applied to selected text.

E Use the Shift+F3 shortcut to quickly cycle through each available font type to see what it will
look like when applied.

Select each font by clicking it to apply it to the heading text. Keep changing it until you find
something you like.

E All of the above options will work equally efficiently.

To quickly move back to the first cell of your worksheet (usually A1), which
shortcut combination would you use?

ﬂ I would press Ctrl+Up Arrow Key. B I would press Ctrl+Page Up.
I would press Ctrl+Home. ) 1 would press Ctrl+Space.

ICATS IT CONTEST 2018 (ADOLESCENTS - GRADE 9 & 10) ‘
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Study the highlighted cells in the image below and identify which of the
following represents the correct cell address for these cells:

A B & D E F

7 Total sales 50000 78200 89500 91250 308950
8 Costof sales 25000 42050 59450 60450 186950
9 Gross profit 25000 36150 30050 30800 122000
10

11 Overhead 7500 7520 5620 3520 24160
12 Marketing 7000 6630 4500 3200 21330
13 14500 14150 10120 6720 45490
14 Net profit 10500 22000 19930 24080 76510
15 Profit % 21 28 22 26 25
16

ﬂ The cell reference for the selected cells is B:21, C:28, D:22, E:26 and F:25.
E The cell reference for the selected cells is row 15, column F

The cell reference for the selected cells is F4:F5

2] The cell reference for the selected cells is B15:F15

The Recent Workbooks list located in the Backstage View shows all workbooks
recently opened. What action can I take to ensure a workbook remains on
this list regardless of how many workbooks I opened subsequent to opening
this workbook?

ﬂ I can save the Workbook to the Recent Workbooks folder.
E By adding the Workbook to My Favorites on the Quick Access Toolbar.

The Recent Workbooks list automatically keeps all workbooks that have been opened and I
do not need to do anything.

E By 'pinning' the workbook to the Recent Workbooks list by clicking the pin icon located next
to it.

ICATS IT CONTEST 2018 (ADOLESCENTS - GRADE 9 & 10)
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EE which of the following is NOT a paste option in Excel?

ﬂ Paste values — pastes the values of the copied cells only.

E Keep source formatting — pastes the copied cells in the same format as what the originals are
formatted in.

Paste zeros — replaces copied text with zeros containing the same number of decimals as the
originals.

E Paste link — pastes a link to the cell containing the original value.

A user wanted to create a numbered list 1 -10. When he used the Autofill
Handle it created a list of 10 number 1s (as pictured below).
What is the solution?

‘4] A | B c D E
1 NO. Participant
2 1
3 1
a 1
5 1
6 1
7 1
8 1
9 1

10 1
11 1l
12 = e
13

ﬂ Insert the formula =Sum(1) in the first cell before using the Autofill handle to increment each
successive fill by 1 step.

B On the Home tab, go to the Editing group and click the Fill button.
Select cells A2 to A11. On the Home tab select Merge and Centre to create a numbered list.

E Click on the Autofill Options icon that appears just after completing an Autofill and select "Fill
Series' from the options.

ICATS IT CONTEST 2018 (ADOLESCENTS - GRADE 9 & 10)
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XL} which of the following describes the group of cells that are highlighted?

i 1 - Microwoty Encet
nnnnnnnnn Pagitaget - Puiishis  Dita|  Bimism.  Wem
—W A Ckon BTSRRI S| e (R e Canonsl ';
Purie ‘;:::rm", B2 gl e A (B R Diveradmn (S - % oA G
= e —_—
A B £ D
¥
2 $4,356  $5674  $3,674
3 Tuesday $3,453 57,893 $8,796
4 Wednesday $6,783 $9,870 $2,674
5 Thursday 56,784 $5,647 $7,768
6 Friday $2,387 $8,768 $8,876
7 Saturday $9,878 $8,796 $2,341
8 Aggregate Value $33,641 546,648 534,129
9

[y
o

N column

E Line

$13,704
$20,142
$19,327
$20,199
$20,031
$21,015
§114,418

Pie

"
4 tort
£LOmr- g

G

W= 8X

Tk ) T e B

I ==l . 2 L
5 T b

e Seinet

gl

E Area

XD suppose that the class grade for a six-week period is based on 3 tests (T1, T2,
T3), each of which counts for 15%, 4 quizzes (Q1, Q2, Q3, Q4), each of which
counts for 10%, and a homework notebook (HW), which counts for 15%.
The grades are recorded in a spreadsheet similar to the one below.

A B C D E F G H I J
1 [Name | Tt | T2 | T3 | Q1 | @2 | @3 | Q4 | HW | AVG
2 | Jane 87 | 92 | 80 | 76 | 79 | 87 | 74 | 90
3 | Joe 91 | 85 | 77 | 78 | 88 | 9% | 90 | 92
4 | Bill 64 | 72 | 70 | 80 | 81 | 74 | 77 | 80
5 |Brenda | 96 | 88 | 91 | 76 | 91 | 100 | 74 | 98

Which of the following formulas would NOT be a correct calculation of the
six-week weighted average for Jane?

I[N =B2%0.15+C2*0.15+D2*0.15+E2*0.1+F2*0.1+G2*0.1+H2*0.1+12*0.15
] =(B2+C2+D2+12)*0.15+(E2+F2+G2+H2)*0.1
=((B2+C2+D2+12)*1.5+(E2+F2+G2+H2))/10
B) =(B2+C2+D2+12)/15+(E2+F2+G2+H2)/10

_
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It is important to keep in mind what the three things are you would like your
audience to remember when walking away from your presentation. How
can you ensure you bring these three points across clearly?

If you plan your presentation around the main points you wish to make and have a clear
goal in mind for the purpose of the talk.

If you repeat the slides and bullets a few times to ensure the audience remembers them.

If you use controversial, awesome, amazing or unique gimmicks in your PowerPoint slides,
your points will be memorable.

R B

If you use stunning graphics, fonts, slide transitions and animations, your points will be
memorable.

To resize an object both in width and height in a power point presentation
slide, which of the following options will be successful?

Select the object and then drag any of the corner handles of the object to resize it.

Set a value for the width and a value for the height of an object in the Size group under the
Format contextual tab.

& CIE

Right click the object and select Size and Position from the menu list. Set a height and
width value in the Sizes boxes.

All of the above options are correct.
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equipment at the Building and their consent for any informatic
computer to be shared by third parties.

“Monthly” means the first day of the month up and includir
month,

“Reports” means any written record dictated or drafted by tr
the Party's use of it's equipment.

“Payment Due” means the dale effected from the date of this
first become due to the Company;

“Income” means the net income of the Party and 15% of an
course of its business;

Bgeiatt | Wemil % PEEE T

(XZD study the screenshot above. What does the blue wavy line underneath the
word “it's” mean? Choose the most correct option:

u There is a spelling error.
B There is a language error.
The word is used incorrectly.

E None of the above options are correct.
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Which PowerPoint feature will allow you to make only the yellow circled word
to fly in from the left?

Feinda com Lasmpie  Fomeriiont

et [ Ceveggn Trarndrom Aneration S Shew Frvee View T Tl e ity

ESENTATION

i a slide in Micro

ﬂ Transitions E Animations Themes E SmartArt

m How can the risk of unauthorized computer system access be reduced?

m By installing anti-span software E By using a firewall
By setting up a WAN E By encrypting all data stored in the system
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(0¥ A Students in a Texas classroom have been communicating with a class in
New York by videoconference. The two classes find that the images they
receive from each other occasionally freeze for up to 30 seconds before the
video continues. This type of problem can most often be solved by

m increasing bandwidth E upgrading cameras

increasing video resolution ) upgrading monitors

See the image below and answer question 28.

iamchris @hotmail.com
T pasoromice
: ; To use the Quick
Ce: |barry@ ozemail.com.au Address List
Bee: [roger @yahoo.com; lisa@msn.com W! “ late E;;"”

Subject: |computing skills assessment
Attachments: Add/Edit Attachments

XY which of the following statements is correct?

u Barry knows that Roger and Lisa were sent the email.
E Bob knows that Roger and Lisa were sent the email.
Roger knows that Bob and Barry were sent the email.

E None of the recipients knows who sent the email.

’ ICATS IT CONTEST 2018 (ADOLESCENTS - GRADE 9 & 10)
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@ What is the name of the device given below?

Y Network adapter ) Transmitter
Wireless router E Wireless adapter

CE[Y what is the correct HTML for inserting an image?

I <img href="image.png”> I} <img load="image.png”>
<img src="image.png”> E <img content="image.png”/>
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DON'T START ATTEMPTING THE PAPER UNTILINSTRUCTED BY THE INVIGILATORS.

INSTRUCTIONS FROM THE EXAMINATION INVIGILATORS MUST BE CARRIED OUT PROMPTLY.
CAREFULLY RECHECK YOUR NAME, FATHER NAME, SCHOOL NAME, ADDRESS ETC AT THE BUBBLE
SHEET / ANSWER SHEET.

RECORD ALL ANSWERS ON THE BUBBLE SHEET ONLY. SELECT BEST ANSWER FROM THE FOUR GIVEN
OPTIONS AND MARK ONLY ONE OPTION IN EACH QUESTION.

USE BLUE / BLACK INK TO FILL UP THE CIRCLES FOR YOUR ANSWERS ON THE BUBBLE SHEET. USE OF
LEAD PENCILIS NOT ALLOWED.

USE OF ANY HELPING MATERIAL INCLUDING CELL PHONES AND ELECTRONIC DEVICES IS STRICTLY
PROHIBITED.

EVERY CORRECT ANSWER EARNS THREE POINTS. THERE WOULD BE NEGATIVE MARKING. ONE POINT
WOULD BE DEDUCTED FOR EVERY INCORRECT ANSWER.

CANDIDATES MAY NOT LEAVE THE EXAMINATION ROOM UNESCORTED FOR ANY REASON, AND THIS
INCLUDES USING THE WASHROOM.

NO MATERIALS OR ELECTRONIC DEVICES SHALL BE BROUGHT INTO THE ROOM.
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NO CANDIDATE SHALL TAKE OUT OF THE HALL ANY ANSWER BOOK(S) OR PART OF AN ANSWER BOOK,
WHETHER USED OR UNUSED, OR OTHER SUPPLIED MATERIAL.

IFAPARTICIPANT DOES NOT UNDERSTAND A WORD OR PHRASE ON THE EXAM PAPER,

NEITHER EXAMINER NOR INVIGILATOR IS PERMITTED TO ANSWER.
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PLEASE VISIT WWW.CATSCONTESTS.ORG

ANY ACADEMIC MISCONDUCT OR MALPRACTICE MUST BE REPORTED TO INTERNATIONAL CATS
CONTESTS AT INFO@CATSCONTESTS.ORG




(39 The fourth generation computers are based on

|A| Transistor | |B | Integrated circuit | |C | VLSI microprocessor | |D | ULSI microprocessor

You have used the keyboards so many times. You must be very conversant with
the keys. Caps Lock is a

| A | Window key | | B | Cursor control key | |C | Toggle key | | D | Modifier key |

How do you insert characters that are located at the top of keys on your
keyboard, for example the question mark symbol?

|A | Hold down the Ctrl key whilst pressing the required key. |

| B | Hold down the Shift key whilst pressing the required key. |

| C | Hold down the key containing the character you require until the correct character appears. |

| D | Hold down the Spacebar whilst pressing the required key. |

m When the user clicks and drags a file to another folder on same drive, the file is:

IéATS’ﬁ'CpntestZOIQ (Adolescents - Grade 9 & 10).-




X which term is commonly used to refer to program errors?

In Microsoft WORD, which feature do you use to create a newspaper like
document?

| A | Bullets & numbering | B | Tables C | Columns D | Tab stops

Study the screenshot below. The button labelled Legal is circled in yellow.
What is the purpose of this button?

7 Portrait Orientation

_I Legal

Wide Margins
j Leftt 2° Right: 2
1 Page Per Sheet

Page Setuy

|A | Use this button to set the page margin type. It is currently set to Legal Margins. |
| B | Use this button to format the document in a specific way. The current format is Legal. |

C | Use this button to set the paper size that the document will be printed on. The current
paper size is Legal.

| D | None of the options listed above are correct. |
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Study the screenshot below of a Microsoft Word document in Print Preview.
It looks like part of the document is cut off on the right-hand side. Which of
the following options will resolve this issue?

MAP OF THE WORL

The map above is a political map of the world center
Europe and Africa. It shows the location of most ¢
world's countries and includes their names where
allows. Representing a round earth on a flat map re

A | Unfortunately this is a formatting issue and you will need to reformat the document to ensure
it fits on the page.

| B | Change the paper size to A4 (8.27" x 11.69"). |

| C | Change the margins to Wide Margins in the Printing area of the Backstage view. |

| D | Change the page to Landscape Orientation in the Printing area of the Backstage view. |

m Fatima needs to number the pages of a document for her boss.
She double-clicks in the footer of the first page of the document and types the
words: “"Page 1”. She continues to number the rest of the 27-page document in
the same way. Which of the following do you think best describes what is right
or wrong about her approach?

A | Nothing wrong with her approach, this is an effective method for inserting page numbers
to a document.

B | Nothing wrong with her approach, the page numbers will automatically update when she
exits the footer of the document.

| C | This approach will not work unless she inserts section breaks into her document. |

D | Her page numbers will not update automatically and all the pages in her document will be
numbered Page 27.
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Study the screenshot below. What does the blue wavy line underneath the
word “it's” mean? Choose the most correct option:

equipment at the Building and their consent for any information
computer to be shared by third parties.

“Monthly” means the first day of the month up and including month.

“Reports” means any written record dictated or drafted by third Party’s use of it's
equipment.

“Payment Due” means the date effected from the date of this first become due to
the Company;

“Income” means the net income of the Party and 15% of any course of its business;

| A | There is a spelling error. | | C | The word is used incorrectly. |

| B | There is a language error. | | D | None of the above options are correct.

Which of the following is the correct shortcut key to align text to the center
of a page?

[B | Ctrl+Shift+c |

éATS,ﬁ'CpntestZOIQ (Adolescents - Grade 9 & 10) .20




Study the screenshot below. When reviewing this document, Lauren noticed
that there were several instances where a heading was on a separate page
from the paragraph that followed it. How can she fix this and stop it from
happening again?

Who we are?

ICATS is an expert group of teachers, researchers, community members and
assessment solution developers in the fields of education and sports who
believe that living standards of people can be improved through learning and
creating a global competitive environment. We are dedicated to help students
(future leaders) judge their hidden potential and employers to make informed
decisions about people and projects.

Our Mission

To be the leading global assessment and testing organization - the first choice
of students, teachers, and employers.

Our Vision
To provide people an opportunity to test their educational and sporting skills
before their application in the competitive world.

A | If she presses enter a few times before the heading, it will move the heading down to the
next page.

B | If she selects the text and then tick: Keep Lines Together in the Paragraph dialogue box under
the Line and Page Breaks tab, it will keep the lines of text and the heading together.

C | If she selects the text and then tick Keep With Next in the Paragraph dialogue box under the
Line and Page Breaks tab, it will keep the lines of text and heading together.

D | If she selects the text and then press Ctrl+Shift+Enter, it will manually keep lines of text
together.
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Which of the following represent the correct sequence of actions to copy and
paste formatting using the Format Painter?

A | Select text to copy formatting from, press the Format Painter button and use the format
painter to paste the formatting.

| B | Double click the format painter button and paint the text you wish to reformat with it. |

C | Select text you wish to apply the formatting to, double click the format painter and then
paint the text with it.

D | Select text to copy formatting from, press the Format Painter button and press escape.
Use the Format painter button when you wish to recreate the copied formatting.

(CZZ Which of the following statements about the Clipboard is UNTRUE?

| A | The Clipboard can store up to 24 items. |

| B | The dialogue box launcher in the Clipboard group launches the Clipboard. |

C | You can only copy not cut items onto the clipboard. Cut items will not appear on the
Clipboard.

| D | You can use the Clipboard to repeatedly paste from the selection of items on it. |

In Microsoft Excel, to quickly move back to the first cell of your worksheet
(usually A1), which shortcut combination would you use?

|A | T would press Ctrl+Up Arrow Key. |

| B | I would press Ctrl+Page Up. |

| C | T would press Ctrl+Home. |

| D | I would press Ctrl+Space. |
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Study the screenshot of a section of a worksheet below. The current selected
cell is B5. What will happen if the shortcut combination Shift+Space is
pressed with this cell selected?

A B
FLIGHT TIMES
A&y or N

MONDAY 13:02:00
TUESDAY 13:00:00
WEDNESDAY 13:42:00
THURSDAY
FRIDAY
SATURDAY
SUNDAY

W oo s~ O n b W N e

b
o

11 2 hours 46 minutes

12
13

| A | The entire Row 5 will be selected. | | C | The entire worksheet will be selected. |

| B | The entire Column 5 will be selected. | | D | The cell contents will be duplicated. |

Laurie is making a presentation for her boss. She often needs to print, change
page set-up and spellcheck slides. She hates having to search for these
function buttons in different places on the Ribbon every time she wishes to
use them. What is the solution?

A | She could add the buttons for the above functions to the Quick Ribbon Status Bar at the
bottom of the screen.

B | She could add the buttons for the above functions to the Quick Access Toolbar at the top
left-hand corner of the screen.

| C | She could create shortcuts on her desktop for the above functions to ensure quick access. |

D | She could add all of the above functions to the Status Bar at the bottom of the
PowerPoint screen.




@ Study the screenshot below. Ahmad was busy working on a chart in Excel
using design, layout and format options that he found on the Ribbon under
separate similarly-named tabs. However, these tabs have now disappeared
and he cannot find the options again. What can Ahmad do?
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| A | He needs to click on the chart for the tabs to reappear. |

| B | He needs to exit the worksheet and go back in again. |

| C | He needs to click on the Insert tab to access these options. |

| D | He needs to click on the Home tab to access these options. |




m Study the image below this question. The Quick Access Toolbar is appearing
below the Ribbon (circled in orange). How would you go about moving it back
to its position above the Ribbon?
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A | This is a default setting with some versions of Excel. You need to reinstall Excel to fix
this issue.

B | You can move the toolbar back up to its position by holding down the left mouse button
and dragging it into position.

C | If you close the workbook and reopen it again, the toolbar will move back to its original
position.

D | If you right click on it and select "Show Quick Access Toolbar above the Ribbon" it will
move back.




m Study the image of a sample worksheet below this question. Which view
type does this represent?

s Q) (3
- =
.
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What is 2+27

What C datatypes are 8 bits? (assume i386)

Bagpipes are awesome.

How have the original H Hornbostel buildings

influenced campus arclma@ @ignﬁhe last

30 years?

Rank the following in their order of operation. Parentheses

The student activities fee is 95
Match the lower-case greek letter with its capital form. X

|A | The Normal View | | C | The Page Break View |
| B | The Page Layout | | D | The Zoom View |

m Study the screenshot below. In chart anatomy, what is the area circled in
yellow called?

Grades Per Group

= Semester 1
B Semester 2
m Semester 3

m Semester 4

1st Grade 2nd Grade 3rd Grade 4th Grade

| A | This is called the Legend of the chart. | | C | This is called Axes Titles. |
| B | This is called Data Labels. |




m Study the screenshot below. How can the amounts in the data labels on each
segment of the Pie Chart be displayed as percentages in addition to the
amounts currently displayed?

$18,000.00 522,000.00

A | By inserting a formula to convert data to percentages in the original data set that the
chart is based on.

| B | By deleting the amounts and typing in the percentages in the Data Labels. |

C | By right-clicking on any of the Data Labels, selecting Format Data Series and ticking the box
for Percentage under the Label Options.

D | By right-clicking on any of the Data Labels, selecting Format Data Labels and ticking the box
for Percentage under the Label Options.

@ What happens if you select a cell that already contains text or numbers and
you start typing or inserting numbers?

A | The above action will add the additional text and/or numbers to the end of the existing
contents of the cell.

B | The above action will delete the current contents of the cell and replace it with the next
typed text or numbers.

C | The text or numbers you type will automatically be appended to the end of the existing
contents of the cell.




m Study the worksheet below. How would you go about repeating the rows at
the top that contain the title as well as the column headings (circled in yellow)?
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A | Select the rows and press Copy, open Page Break Preview and then Paste the rows at the
top of each page.

B | Select the rows and under the Page Layout tab on the Ribbon, tick the box next to Repeat
as Header Row.

C | Under the Page Layout tab on the Ribbon, click on Print Titles. Insert the row references
into the Rows to Repeat at top box and press OK.

| D | All of the above options are correct. |
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Study the screenshot below. James applied a Sort to this worksheet, sorting
alphabetically in ascending order according to Name, but for some reason the
column title have also moved. Why did this happen?
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'

| A | James selected the header row before he pressed the Sort button and it was included. |

B | James did not format the header row correctly to ensure it is separate from the rest of
the data.

| C | James did not tick the box My Data has Headers in the Sort dialogue box. |

| D | James did not highlight the header row and tick the box My Data has Headers before sorting. |

Study the screenshot below. What formula can you use to change the case for
the surnames in cells B2:B8 to match the case of the names in column A2:A8?

| A | The PROPER function. |

| B | The UPPER function. |

| C | The LOWER function. |

| D | The INITIAL_CAPS function. |

FIELDS
Loraine DU PLESSIS
Jessica BRUMBLEBY
Patricia LAURES
Charlotte PERCO
Carla DEKKER

0NV A WN =
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Study the screenshot below. What is the name of this view?
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| A | The Notes View | | C | The Outline View |
| B | The Presenter View | |D | The Slide View |

m Programs that are automatically loaded and operated as a part of browser are
known as

TS,IrI'CAontest2019 (Adolescents - Grade 9 & 10) ;




@ Which of following is NOT a name for an item that could be a security threat
to your computer?

|A | trojan horse | | B | metacrawler |

@ It is sometimes referred to as potentially unwanted programs (PUPs), not
obviously malicious and is not classified as a virus, but it can still be irritating
and even harmful. It includes files or applications that can carry out unwanted
actions, such as tracking your behaviour online or sending you a barrage of
pop-up windows. It is a program that runs in the background on your
computer, sending information about your browsing habits to the company
that installed it on your computer. What is this called ?

A | Pop-ups B | Adware C | Grayware D | Spyware
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INSTRUCTIONS

B Please recheck your Name, Father Name, Grade and School written below, the same would appear at your certificate.

This is a generic answer sheet to be used by participants of all grades. Students of Grade 1-2 will fill in circles of

first 20 questions, Grade 3-4 will fill in circles of 25 questions and Grade 5-10 will fill in circles of 30 questions.

Use of lead pencil is not allowed.

B Use only Black / Blue ink to fill in the circles.
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